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MINISTER’S FOREWORD 
 
This Users’ Manual and the accompanying presentations have been 
designed to support affordable housing partnerships between local 
government and the community housing sector in NSW.  They have been 
developed through consultation with key stakeholders, including 
representatives of local government, the community housing sector and 
state government agencies.   
 
Tackling housing affordability in NSW will require participation from all levels 
of government and a range of new private partners.  With this project, we 
are supporting community housing providers to establish links and 
partnerships with local government – a key player in the drive towards more 
affordable housing. 
 
Establishing new ties with local government will enable the community 
housing sector to pursue affordable housing projects, build on their 
experience and expertise, and take on a new range of roles in building, 
owning and operating more housing. 
 
The NSW Government is committed to expanding the role of community 
housing in affordable housing.  We recognise the importance of housing 
affordability and its links with other social outcomes and improving the urban 
environment.  Community housing providers play an important role in 
supporting low-income households to find and access affordable housing. 
 
The NSW Government has demonstrated its commitment to the community 
housing sector through Planning for the Future: New directions for 
Community Housing in New South Wales 2007/08 – 2012/13, the five year 
strategy for growth and sustainability. 
 
Planning for the Future recognises that a strong partnership approach 
between the whole community housing sector and its partners is the key to 
meeting growing and diverse community needs and successfully responding 
to the housing affordability challenge. 
 
By continuing to work in partnership with all levels of government and our 
non-government partners, we are confident we can boost the provision of 
stable and affordable housing for people who are finding it tough to afford 
housing in the private market. 
 
The Hon Matt J Brown 
Minister for Housing 
Minister for Tourism 



 �
��

ACKNOWLEDGEMENTS  
 
 
Funding for this project was provided by: 
 
NSW Centre for Affordable Housing  
and  
NSW Office of Community Housing  
 
 
Project Steering Committee  
 
The Centre for Affordable Housing would like to thank members of the Project 
Steering Committee for their advice and assistance throughout the development of 
this Affordable Housing Presentation Kit.  These were: 
 
Gayle Adams Office of Community Housing, Housing NSW  
Sally Anderson-Day Gosford City Council  
Marg Bicskos Shoalhaven Community Housing Scheme Ltd 
Caroline Egberts NSW Department of Local Government  
Will Roden Centre for Affordable Housing, Housing NSW  
Daniel Thorpe (Formerly of) City of Sydney Council  
Peter Usher Housing NSW 
 
This Kit has been updated by Clara Dolce and Will Roden from a booklet and 
presentation prepared by: 
 
Judith Stubbs & Associates  
2C McCauley St 
Thirroul NSW 2515 
judystubbs@bigpond.com.au 
 
Copies of this Kit can be obtained by contacting: 
 
Centre for Affordable Housing 
Housing NSW 
Locked Bag 4001 
Ashfield  
NSW BC1800 
 
Phone: (02) 8753 8185 

 
 
 
 
 
 



 �
��

TABLE OF CONTENTS  
 
 MINISTER’S FOREWORD  

 
2 

 ACKNOWLEDGEMENTS  
 

3 

1. PURPOSE OF THIS USERS’ MANUAL  
 

5 

2. PREPARING & GIVING THE PRESENTATION  
 

9 

3. THE BASIC PRESENTATION – THE CORE SLIDES  
 

o Slide 1 – Title Slide  
o Slide 2 – Purpose  
o Slide 3 – My Organisation  
o Slide 4 – The Affordability Problem 
o Slide 5 – The Scale of the Problem  
o Slide 6 – Not Just a Sydney Issue  
o Slide 7 – The Local Context – Part 1 
o Slide 8 – The Local Context – Part 2 
o Slide 9 – The Economic and Social Impacts  
o Slide 10 – What is being done to address this? 
o Slide 11 – Affordable Housing Innovations Fund 
o Slide 12 – What can we do at the local level? 
o Slide 13 – Role of Local Government in the Partnership  
o Slide 14 – Role of Community Housing in the Partnership  
o Slide 15 – What can my Organisation bring to the Partnership? 
o Slide 16 – Where to from here? 
o Slide 17 – Acknowledgments  
  

11 

4. SUPPLEMENTARY SLIDES  
 

Section 1 – Role of Local Government  
o Slide 1 – Local Government Role in Affordable Housing – 

Context  
o Slide 2 – Mechanisms Available to Council  
o Slide 3 – Affordable Housing Mechanisms (1) 
o Slide 4 – Affordable Housing Mechanisms (2) 
o Slide 5 – Affordable Housing Mechanisms (3) 
o Slide 6 – Affordable Housing Mechanisms (4) 
 

Section 2 – Affordable Housing Partnership Examples   
o Slide 7 – Debt Financing Partnership 
o Slide 8 – Planning Partnership  
o Slide 9 – Partnership on Surplus Land  
o Slide 10 – Partnership Using Environmental Planning 

Instruments  
o Slide 11 – Section 79C Example  
o Slide 12 – Self Build Partnership 
 

41 
 
42 
 
 
 
 
 
 
 
 
52 

 LIST OF ACRONYMS 60 



 �
��

 1. PURPOSE OF THIS USERS’ MANUAL 
 
1.1 Overview  
 

This Users’ Manual has been prepared by the NSW Centre for Affordable 
Housing and the NSW Office of Community Housing.  It supports a visual 
Presentation that community housing providers can use to initiate 
discussion with their local council about the establishment of an Affordable 
Housing Partnership in their Local Government Area (LGA). 
 
It can also be used by those community housing providers who are at a 
more advanced stage with their local council to begin the process of talking 
through some practical examples of how the two organisations can work 
together.  
 
The Presentation aims to be relevant and accessible to all councils, 
including those who have limited involvement in affordable housing to date. 
 

1.2 Generic and Area / Organisational Specific Slid es  
 

The overhead slides for the Presentation have been prepared using the 
Microsoft PowerPoint program.  They consist of: 
 
�  Generic slides, which contain information that can be used by 

presenters from all council areas; 
�  Templates for area / organisational specific slides, into which 

information relating to specific local areas or to a specific community 
housing provider can be inserted.    

 
The Users’ Manual and Presentation can therefore be used by any 
community housing provider, and provides guidance about preparing and 
inserting local information into the area / organisational specific slides. 
 
The Users’ Manual also contains some ‘Notes to Presenter’, which provide 
basic information on the slides and can be used as a basis for preparing the 
presenter’s speaker notes.  
 

1.3 Content of Users’ Manual and Presentations   
 
 The Basic Presentation sets out: 
 

�  What ‘affordable housing’ is and why it is important; 
�  Issues related to affordable housing in NSW and the particular local 

area in which your organisation is located; 
�  The roles and responsibilities of local government in addressing the 

need for affordable housing; 
�  Information on community housing providers and their contribution to 

affordable housing solutions; and  
�  General information on the development of an Affordable Housing 

Partnership. 
 

This Users’ Manual assumes no knowledge of the affordable housing 
agenda but recognises that some community housing providers are at 
different stages in the process of engagement with their local council.  For 
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those providers who are at a more advanced stage with their local council, 
there are separate sections to both the Users’ Manual and Presentation 
(within the Supplementary Slides) that set out: 
 
�  Specific mechanisms available to local councils which they can use to 

generate their contribution (housing or cash) to an Affordable Housing 
Partnership; and  

�  A range of options for partnerships between community housing 
providers and local government to develop affordable housing. 

  
Section 2 of the Users’ Manual provides information on customising the 
presentation and presenting the presentation.  It provides some information 
on the more technical aspects of preparing the presentation. 
 
Sections 3 and 4 of the Users’ Manual contain the following sections under 
each slide within the presentation: 
 
�  Things to do in Advance;  
�  Notes to Presenters; and  
�  Background Information. 
 
These notes provide guidance to the presenter on approaches that could be 
used during the presentation, the source of other material that may be 
useful, and so on.     
 
The Users’ Manual also provides links to, or information about, other 
sources of data and information.  Whilst it is not necessary to go to this level 
of detail to do a presentation, these provide valuable background and 
resources for the presenter.  The references and links to resources will 
enable presenters to ‘drill down’ as far as they need or wish to about 
affordable housing issues in general, or in their particular local area. 

 
1.4 Useful Information about Your Council     
 

It is highly recommended that you do some research about your council 
prior to your presentation.  It is extremely important that you go into your 
meeting with the council knowing what they are doing / planning to do in 
regard to affordable housing.  Useful documents that you may wish to look 
at include: 
 
�  Your council’s Local Environmental Plan (LEP) – check if there are any 

objectives or special provisions regarding affordable housing; 
�  Relevant Development Control Plans (DCPs) – check if there are any 

that relate to affordable housing, or support relevant provisions within 
the LEP; 

�  Affordable Housing Plan or Local Housing Studies – even though many 
councils will not have specific provisions in their planning instruments 
(LEP, DCPs, etc), they may have other documents that set out their 
views on local needs and priorities, or their strategic directions in 
relation to affordable housing; 

�  Social or Community Plan – all councils in NSW are required to have 
such a document.  Although local needs are often reported by ‘target 
group’ rather than being ‘issue-based’. 
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You can find these documents by asking the Community Services, 
Planning, or Environment sections of your local council; or check your 
council’s website (if they have one). 
 
Some knowledge of these documents will help in your discussions with the 
council during or following the Presentation.  They will also provide a ‘point 
of entry’ in any negotiations about a possible role for the council by showing 
you are aware that your council does have an awareness of housing issues, 
as reflected in their documents or strategic position. 
 
You may also wish to review census or other data about your local area in 
preparation for the Presentation or your first meeting with council staff, in 
addition to that which accompanies this Kit.  Data is also available from the 
Centre for Affordable Housing’s Local Government Housing Kit.   
 
The NSW Local Government Housing Kit has been created to help councils 
understand housing needs and issues in their region, and to formulate 
appropriate responses to those needs using a strategic approach, 
accessible information and practical applications.  The Database in the Kit 
has a range of basic quantitative data on local government areas in NSW.  
The Database can be accessed on the Centre’s website: 
http://www.housing.nsw.gov.au/Centre+For+Affordable+Housing/NSW+Loc
al+Government+Housing+Kit/Local+Government+Housing+Kit+Database.ht
m. 

 
1.5 Involving Your Council from the Beginning  

 
It is strongly recommended that you involve appropriate staff from your 
council in all aspects of the presentation as early as possible.  Appropriate 
staff are likely to be Strategic, Town or Social Planners, Housing Officers or 
Community Services Officers.  Due to the technical nature of some of the 
planning and regulatory issues covered in this Users’ Manual, you may find 
your Town, Social or Strategic Planners very useful.  They are good people 
to involve in and educate about local housing issues in an ongoing way, and 
will have research that will assist your organisation’s planning and 
development. 
 
It is recommended that you: 
 
�  Approach relevant council staff early, i.e. as you plan your presentation, 

and compile local data and information; 
�  Ask them to co-present, particularly on the information that relates to 

them and on the more technical planning issues that may arise during 
the presentation, or on other complementary matters (e.g. relevant local 
planning provisions, strategic or housing studies); 

�  Co-ordinate your presentations regarding the types of information each 
of you present – you may wish to delete the slides from your 
presentation that will be covered by council staff to avoid duplication.  

 
You may find that you receive a more positive reception by councillors if 
staff (particularly senior staff) are involved in your presentation, or do their 
own mini-presentation on related matters. 
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Where council staff are not available to assist you or to co-present, you may 
wish to contact the Centre for Affordable Housing (CAH), or the NSW 
Federation of Housing Associations.  They can discuss the more technical 
aspects of your presentation, or may be able to provide you with a co-
presenter to assist with material on which you are not comfortable 
presenting. 
 
The CAH can be contacted as follows: 
 
By Phone:    (02) 8753 8185  
By Post:   Centre for Affordable Housing, Locked Bag 4001, Ashfield 

NSW BC1800 
 
The NSW Federation of Housing Associations can be contacted as follows: 
 
By Phone: (02) 9281 7144 
By Post:  Suite 301, 64-76 Kippax Street, Surry Hills NSW 2010  
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2. PREPARING & GIVING THE PRESENTATION  
 
2.1 ‘Core’ and ‘Supplementary’ Slides  
 

There are PowerPoint files included in this presentation package.  One 
contains the ‘core’ slides of the presentation and the other includes the 
‘supplementary’ slides.  
 
The core slides  are the basis of the presentation (‘Basic Presentation.ppt’).  
The PowerPoint file containing the core slides may be given as a 
presentation on its own without any of the supplementary slides being 
added.   
 
The PowerPoint file containing the supplementary slides  is not  intended 
to be given as a presentation on its own (‘Supplementary Slides.ppt’).  The 
purpose of this file is to provide supplementary slides, which may be added 
to the basic presentation if desired by the presenter.   

 
2.2 Where do the ‘Supplementary Slides’ fit into th e ‘Basic Presentation’? 
 

The Supplementary Slides have been included to provide more detail on the 
mechanisms available to councils in generating affordable housing and 
some practical examples of what the Affordable Housing Partnership can 
do.  These slides should be included (if needed) at an appropriate point in 
your presentation.  There are two sections to the supplementary slides, 
which indicate an inclusion point within the presentation.  Detail on the 
supplementary slides can be found in Section 4 of this Users’ Manual.    

 
2.3 Inserting Supplementary Slides into the Basic P resentation File  
 

The following is a set of step-by-step instructions on how to insert the 
supplementary slides into the Basic Presentation PowerPoint file. 
 
1. Open the PowerPoint file containing the supplementary slides. 
2. On the menu bar at the top of the screen, click the ‘View’ menu button, 

which will pull down the view menu, and click ‘Slide Sorter’. 
3. Click the slide that you wish to insert into the presentation.  
4. On the menu bar at the top of the screen, click the ‘Edit’ menu button 

and click the ‘Copy’ button on the menu.  This will copy the highlighted 
slide.  Alternatively, you can use the copy shortcut (hold the ‘Ctrl’ button 
on your keyboard and press the ‘C’ button). 

5. Open the PowerPoint file containing the core slides. 
6. Pull down the ‘View’ menu as in step 2 and click the ‘Normal’ button on 

this menu. 
7. Click on the left of the screen where the numbers of the slides are listed 

and scroll through the slides (using the up and down keys on the 
keyboard) until you find the slide which comes just after the 
supplementary slide which you are inserting.  The numbers listed on the 
left are not necessarily the core number, only the number of the slide in 
order of presentation.  These numbers will change once slides are 
inserted.   

8. Pull down the ‘Edit’ menu as in step 4 and click the ‘Paste’ button.  
Alternatively you can use the ‘Paste’ shortcut (hold the ‘Ctrl’ key on your 
keyboard and press the ‘V’ button). 
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9. This will insert the slide into the Basic Presentation file.  Repeat steps 1 
to 8 for any other slides you wish to insert and then pull down the ‘File’ 
menu, click ‘Save As’, type the new file name and press ‘Save’. 

 
2.4 Personalising Your Presentation and Preparing Y our Speaker Notes   
 

Some of the slides within the presentation have gaps that need to be filled 
in by the presenter.  In order to help you do this, please refer to Sections 3 
and 4 of this Users’ Manual, which contain specific information on each 
slide in the presentation.  As part of this, there is a ‘Things to do in Advance’ 
section, which details specific information that needs to be inserted. 

 
To help you write your speaker notes each slide in Sections 3 and 4 of this 
Users’ Manual also contains a ‘Notes to Presenter’ section.  This details 
among other things important points to be emphasised when delivering the 
presentation.  It is important that you do not just read the information on the 
slide during the presentation but that you construct a set of speaker notes 
that are specifically tailored to your audience.  
  

2.5 Giving the Presentation         
 

Using your speaker notes that you have prepared as a guide, you are now 
ready to give your presentation, provided that you have read through and 
become familiar with the contents of this Users’ Manual.  The speaker notes 
should detail information on each slide, and you should study these prior to 
giving the presentation so that you are familiar with what you are going to 
say on each slide.  Being familiar with what you are going to say during your 
presentation is essential to being confident and maintaining eye contact 
with your audience.  The speaker notes may be kept on hand so that they 
may be glanced at from time to time, but they should not be relied upon.     
 
To start your slide show in PowerPoint, firstly open your presentation in 
PowerPoint.  Next, pull down the ‘View’ menu and select ‘Slide Show’.  
Alternatively, you can start your slide show by pressing the ‘F5’ key on the 
keyboard. 
 
To advance to the next slide, you may either click your mouse or press the 
right arrow key on your keyboard.  To move back to a previous slide, press 
the left arrow key on your keyboard.  Alternatively, you can click the right 
mouse button, which will bring up a menu, and click the ‘Previous’ option. 
 
You should practice giving the presentation until you are confident with what 
you will say without relying on your speaker notes.  You may wish to 
practice on a colleague prior to presenting in front of an audience and ask 
them for feedback.  This is a good idea, because it will give you an idea of 
the sorts of things that you may wish to practice and improve upon. 
 
It is estimated that it should take approximately 20 minutes to complete the 
basic presentation.  With supplementary slides, the presentation could take 
up to 40 minutes. 
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3. THE BASIC PRESENTATION – THE CORE 
SLIDES  

 
Core Slide 1 – Title Slide  
 

Local Government & Community Affordable 
Housing Partnerships

[NAME] Council 

[Presenter’s Name ] 

Logo 
here

 
 
Things to do in Advance    

 
�  Insert the name of your organisation and local council as indicated on the slide. 
 
�  Insert your organisational logo (if you have one) at the bottom of the slide. 
 
Notes to Presenter  
 
�  Introduce yourself and your organisation, and thank the council for the 

opportunity to present on Affordable Housing needs and opportunities.  
 
�  If you have a co-presenter introduce them here.   
 
�  It is a good idea to acknowledge something positive about your council early in 

the presentation.  For example, you may comment briefly on any involvement 
your council has had in identifying or working on affordable housing needs or 
issues.  Emphasise the positive nature of their approach to date if possible at 
the outset of your presentation (e.g. if they have provisions in the LEP, or have 
done a housing study or strategic plan, or a housing partnership).   
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Core Slide 2 – Purpose  
 

Purpose

AFFORDABLE HOUSING 

� What is it?

� What is the scale of the problem?

� Why do we need it?

� What roles do we play in its provision?

� What action can we take at a local level?

 
 
Notes to Presenter 
 
This slide briefly explains the purpose of the presentation.  It might be helpful 
before you go on to talk about this slide to provide a definition of Affordable 
Housing as part of the first bullet point: 

 
“As you know, I am here today to talk about the issue of affordable housing.  
Housing is considered to be ‘affordable’ when it is priced so that other essential 
costs like food, clothing, transport and services can be adequately met.  This is 
generally where housing costs are less than 30% of gross household income 
for low to moderate income households.  Among very low, low and moderate 
income households (those whose income is up to 120% of median household 
income), there is a diverse and growing group who cannot access affordable 
and appropriate housing in their local area.  The target group for affordable 
housing is generally households with incomes of up to 120% of the median 
income (that is, 20% above the median, or up to $66,361 in NSW, and $73,919 
in Sydney, in 2006 dollars).”    

 
In terms of explaining the purpose of the presentation – the following could be 
stated: 
 

“I hope that this presentation is a first step in working together to improve 
affordable housing opportunities at the local level.  Affordable housing is one of 
the most important issues to face us – this has recently been echoed by the 
Premier.  In his speech in Poverty Week 2006, the Premier echoed the Senate 
inquiry report’s finding that housing is the linchpin of social inclusion and the 
Premier recognised the need to assist ‘low to moderate-income families who 
find housing costs a burden, whether they are renting accommodation or 
paying off a home’.” 
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“On announcing the 5 year strategy for community housing, Planning for the 
Future, Minister Matt Brown noted the need to widen the role of the community 
housing sector in the supply of affordable housing.  Affordable housing is a key 
challenge for all of NSW and by working with our partners, community housing 
is committed to doing its part to address this challenge.” 
 
“In terms of the structure of this presentation, I would like to talk about my own 
organisation and then talk to you about why Affordable Housing matters.  I will 
then look at some of the ways that local councils and community housing 
organisations can have an impact on housing affordability at the local level.  
However, the main focus of the presentation will be on how we can work 
together to develop an Affordable Housing Partnership.”     
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Core Slide 3 – My Organisation  
 

My organisation

� Part of the community housing sector 

� Delivery of social housing by the not-for-profit 
sector 
� Delivery of flexible and innovative housing 
solutions 

� [Name of Organisation to be added here] 
(Information to be inserted here by community 

housing provider – please refer to the Users 
Manual)

 
 
Things to do in Advance  
  
Insert information as part of the second bullet point on your own organisation.  The 
name of your organisation should first be inserted and you should then go on to 
insert a maximum of 2 or 3 bullet points to provide the audience with an overview of 
your organisation.  This could include information on the following: 
 

�  Type of community housing provider – i.e. Housing Association, Co-
operative, etc 

�  Date established   
�  Number of capital properties / leasehold properties  
�  Accreditation / registration status    
�  Areas of operation i.e. location wise  
�  Areas of business (e.g. general, supported, affordable housing) 
�  Governance structure (ie. incorporated under Associations Act or 

Cooperatives Act and managed by a Board of Directors)    
  
It is important that you do not go into detail about your experience in the delivery of 
affordable housing as this will be covered in slide 15. 
 
Notes to Presenter 
 
This slide provides you with the opportunity to provide the audience with some 
background information on both the community housing sector and on your own 
organisation.  Therefore you might want to start with something general like: 
 

“Before I start to talk about Affordable Housing I want to provide you with a little 
background information on the community housing sector and my own 
organisation.”  
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You should now provide an overview of the community housing sector – as part of 
this you may want to cover some of the following facts: 
 
�  Within NSW, community housing is provided by the not-for-profit sector as part 

of the social housing system.  The community housing sector has the ability to 
provide a wide range of housing options from crisis housing for the homeless 
through to affordable housing.  This is because of a variety of business models, 
human resource structures and property portfolios.  The sector also plays an 
increasingly important role in community building in some communities, as the 
sector grows this role is likely to expand. 

 
�  The sector is increasingly providing affordable housing, playing a development 

role and working in partnership with local council and the private sector. The 
sector is moving towards providing a continuum of housing options to house 
very low income earners to moderate income earners finding it difficult in the 
private market. 

 
�  Community housing makes up about 9.3% of properties within the social 

housing system – which equates to over 14,000 properties – NSW has the 
largest community housing sector in Australia. 

 
�  Community housing providers come in a wide variety of sizes and types – 

Housing Associations, Housing Co-operatives, and Housing Partnerships 
providing housing assistance with organisations such as churches, charities 
and local government - in total there are around 391 not-for-profit housing 
providers in NSW. 

 
�  The sector achieves wider benefits – it encourages local enterprise and 

voluntary action by building trust and goodwill among its partners and tenants, 
and attracting support from local community leaders and businesses. The 
sector has demonstrated strong capacity for tenant participation in different 
ways, from input at board level to participative structures such as tenant-
managed co-operatives. 

 
�  The sector achieves very high levels of tenant satisfaction – from 78% in 2002 

to 86% in 2005 (figures taken from Community Housing National Social 
Housing Survey, 2005).  

 
�  The sector is supported by the Office of Community Housing, which is a 

business unit of Housing NSW.  The Office has responsibility for the planning, 
monitoring, regulation and capacity building of the sector.  Further information 
on the Office, can be found at: http://www.housing.nsw.gov.au/och/och.htm 
 

You should now talk about your own organisation as indicated above in ‘Things to 
do in advance’.  It is important that you keep your explanation of this slide to a 
minimum. 
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Core Slide 4 – The Affordability Problem  
 

The affordability problem

� Home ownership no longer a reality for many
� First home buyers halved since 2001

� Sydney and many regions now unaffordable

� Private rental also unaffordable for many
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Notes to Presenter 
 
�  As part of this slide, you will talk about why we are facing such housing 

affordability problems.  Further details on each of the main bullet points are 
provided below.  

 
�  First main bullet point - The dream of home ownership is no longer a reality 

for many Australians.  The number of first home buyers has halved between 
2001 to 2004 despite low interest rates (Powall & Withers, 2004).  Housing 
prices grew by 70% in real terms in the decade to 2003 (Ibid).  In fact, 
research indicates that there are no local government areas in Sydney 
where a family on median income can afford to purchase a median priced 
home without spending more than 30% of their income (Berry, 2001).  

 
�  Second main bullet point - There are very few local government areas in 

Sydney where a family can afford to rent a home (Berry, 2001).  Rental is 
also unaffordable for many families in regions outside of Sydney (NATSEM, 
2004).  Low cost stock that is lost to redevelopment or strata-subdivision is 
not being replaced.  Growth in rental stock between 1996 and 2001 in NSW 
occurred mainly at the top end of the private rental housing market (Yates, 
Wulff & Reynolds, 2004).  Older and young renters, single people and 
single income households are the most vulnerable in the private rental 
market (Brotherhood of St Lawrence, 2003).  However, low to moderate 
working income families also face affordability problems in metropolitan and 
many regional areas (Darcy, Stubbs, Perry & Blunden, 2005).  

 
�  Third main bullet point - There is also enormous pressure on rental at the 

lowest end of the housing market.  There are over 45,000 households on 
the public housing waiting list in NSW.  Waiting times in most regions of 
NSW are generally 8 to 10 years for those on the general waiting list 



 �

��

(Housing NSW, 2007).  Those on the lowest income have also been hard 
hit by the loss of boarding houses, cheaper flats and units and long-term 
sites in caravan parks (Connor et al, 2002).  Very little new stock is entering 
the market at the ‘affordable end’.  The loss of rental at the lowest end of 
the housing market has affected areas throughout NSW (Yates, Wulff & 
Reynolds, 2004).  The overall effect is to increase pressure on the areas 
where there has traditionally been affordable rental stock.  

 
�  In summary, you might want to emphasise that these figures show that housing 

affordability is indiscriminate in who it effects and when and effects the full 
spectrum of low-to-moderate income earners.   

 
Background Information  
 
�  Statistics cited are drawn from a range of sources that provide useful 

background reading.  These are as follows (provided with links where 
available): 

 
�  Yates, J. 2004, ‘Reviewing the Taxation Treatment of Housing’, Housing 

Australians Seminar, 
www.shelternsw.infoxchange.net.au/docs/sem040623yates.ppt 

 
�  NSW Ministerial Task Force of Affordable Housing, 1998, Affordable 

Housing in NSW: The Need for Action, NSW MTFAH, Sydney. 
 
�  Powall, M. & Withers, G.  (2004) Resource Paper, National Summit on 

Housing Affordability, at – 
www.housingsummit.org.au/05/media/resource_paper.pdf 

 
�  Randolph, B. and Holloway, D.  (2004), ‘Shifting Suburbs: Population 

Structure and Change in Greater Western Sydney’, Urban Frontiers 
Program, University of Western Sydney 

 
�  Brotherhood of St Lawrence, 2003, ‘Changing Pressures’, Brotherhood of 

St Lawrence, Melbourne – www.bsl.org.au 
 
�  Yates, J., Randolph, B., Holloway, D. and Murray, D. 2005, ‘Housing 

Affordability, Occupation and Location in Australian Cities and Regions’, 
AHURI (Sydney, UNSW/UWS Research Centres) at – 
www.ahuri.edu.au/global/docs/doc789.pdf?CFID=85602&CFTOKEN=67393
728 

 
�  Berry, M. 2001, ‘New Approaches to Expanding the Supply of Affordable 

Housing in Australia: An Increasing Role for the Private Sector’, Paper to 
the National Housing Conference 24-26 October 2001, Melbourne.    
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Core Slide 5 - The Scale of the Problem     
 

The scale of the problem

� 194,000 private renters –
mostly single people, single 
parents & older people   

� 176,000 purchasers – mostly 
couples with children  

� Spread across income ranges 
& broadly distributed 
geographically 

� Mostly in employment 

� Tend to be younger  

371,000 Households Living in 
Housing Stress in NSW - 2006 

Census 

Purchasers

Private
Renters52%

48%

 
 
 
Notes to Presenter 
 
�  As part of this slide, you will start to look at the scale of the Affordable Housing 

problem. 
 
�  It is important to inform the audience that these figures show that housing 

affordability is a complex problem in that it can affect anyone at any stage in 
their life.   

 
�  You will now go on to talk about whether the affordable housing is dictated by 

geography and also provide some local data on the problem.   
 
Background Information  
 
�  This slide mentions the term ‘Housing Stress’ – this term is used to describe 

households where housing costs are so high that they risk going without other 
essentials such as food, clothing and transport.  The generally accepted 
benchmark for housing stress is if a low to moderate income household spends 
more than 30% or more of their gross household income on housing (either for 
rent or purchase).  This information is derived from ABS data from the 2006 
Census. 
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Core Slide 6 – Not Just a Sydney Issue 
 

Not just a Sydney issue

 
 
Notes to Presenter 
 
�  This slide aims to address the common misconception that affordable housing 

is a ‘Sydney’ issue – this map shows otherwise. 
 
�  Although it is true that the problem is most serious in some parts of Sydney, 

this situation has forced many low and moderate income families out of Sydney 
and so has pushed up prices in areas well beyond the Sydney Greater 
Metropolitan Region.  It then becomes harder for local people in these areas, 
including lower paid workers, young people and older residents, to rent or buy 
in the local housing market.  In this way, affordable housing, including the loss 
of stock at the lowest end of the market, has become a serious issue for many 
areas outside of Sydney.           

 
Background Information 
 
�  This slide shows the proportion of the properties on sale in the period from 

December 2005 to December 2006 that could be afforded by a moderate 
income household paying 30% of its income in mortgage repayments.  It 
assumes that the household has a 10% deposit and took a loan out of 7% 
interest for a 30 period. 

 
�  Another map showing rental affordability for Sydney is available on the website 

for the Centre for Affordable Housing.     
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Core Slide 7 – The Local Context – Part 1  
 

The local context – Part 1

Housing Affordability
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Households
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Purchase
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Notes to Presenter  
 

�  This slide in conjunction with Slide 8 should be used to demonstrate the 
housing affordability problem in your local area. 
 

�  This slide shows the percent of both renting and purchasing households that 
experiencing housing stress in the Parramatta local area in comparison with 
the Sydney Statistical Division, and all of NSW. 

 
Background Information 
 
There are two steps to customising this slide (and slide 8 that follows) for the local 
context.  First, you will need to get data on the local housing market.  Second, you 
will need to create charts that present the data visually. 
 
1. Data on the local housing market: 
 
�  The data is available in the Local Government Housing Kit: 

http://www.housing.nsw.gov.au/Centre+For+Affordable+Housing/NSW+Local+
Government+Housing+Kit/Local+Government+Housing+Kit+Database.htm 

 
�  When you visit the Local Government Housing Kit website, the first thing you 

need to do is to click on the link to Local Government Housing Database.  The 
Database will generate a table in Microsoft Excel with data on the housing 
market in the local area(s) you select. 

 
�  The first page of the Database outlines the three simple steps to getting the data 

you are interested in: 
 

�  Select the LGA for which you want information 
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�  Select some regions to compare your LGA to - these can be other SLAS, 

Statistical Divisions or Subdivisions  
 
�  Select the table you want to generate 

 
Click on ‘Next’ and you will be taken to Step 1. 

 
�  Step 1: Selecting an LGA – This page asks you to identify the LGA that you want 

data on.  You can only select one LGA in this step.  In the example slide above, 
‘Parramatta’ was selected as the LGA.  When you have selected the LGA, click 
on ‘Next’ and you will be taken to Step 2.   

 
�  Step 2: Select a comparison region – On this page you will need to select what 

other areas (either regions or LGAs) you would like to compare your LGA with.  
You can select up to 10 areas.   

 
In the example slide above, it was decide to compare the data on Newcastle with 
the Sydney Statistical Division and all of New South Wales. 
 
To select areas, click on the first area you would like to compare with.  Next, hold 
the Control key on your keyboard (Ctrl) and click on other areas you would like to 
compare with. 
 
To repeat the example in Slide 7, first click on ‘Sydney SD’.  Next, with the 
Control key held down, click on ‘Total NSW’.   
 
When you have selected all the comparison areas you would like data on, click 
on ‘Next’ and you will be taken to Step 3. 

 
�  Step 3: Select the appropriate table – On this page you can identify the subject 

that you would like data on.  You can only select one subject at a time.  In the 
example, ‘Housing Stress’ was selected.  The options are: 

 
�  Population Forecasts 
�  Age and Sex 
�  Trends in Households 

Types and Family Types 
�  Occupancy Rate Trends 
�  Income and Occupation 

Trends 
�  Industry Structure 
�  Unemployment and the 

Labour Force 
�  Dwelling Structure 
�  Dwelling Tenure 

�  Bond Lodgements 
�  Public Housing Stock 
�  Rents, Prices and 

Vacancies 
�  Housing Stress 
�  Percentage of Affordable 

Dwellings 
�  Median Rent and Median 

House Price Data Since 
2001 

 
When you have selected the subject you would like, click on ‘Next’. 

 
�  Depending on your computer settings, most likely a dialogue box will open: 
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Click on ‘Save’ and save the Excel file in an appropriate folder or on your 
desktop.  Then repeat the process for the different subjects you want data on.  

 
2. Creating Charts: 
 
�  The following is a set of step-by-step instructions on how to create a chart in the 

Microsoft Excel program and then paste the chart into a slide in the Basic 
Presentation PowerPoint file. 

 
1. Open the Excel file that you saved in the final step above. 
 
2. There will be a table with several columns.  The first column is the ‘Area’.  

The cells below ‘Area’ will list the areas you selected in the process 
above.  The other columns provide data related to the subject you 
selected above. 

 
3. Decide which columns you would like to include in your chart.  For 

example, in the example for slide 7, it was decided to chart ‘% of 
households in Rental stress’ and ‘% of households in Home Purchase 
stress’. 
 
Make sure the types of data you include in your chart are the same, ie. 
they are all percentages or numbers or dollars. 

 
4. You will now create a new table with only the columns you would like in 

your chart.   
 

Select all of the cells in the first column, ‘Area’. On the menu bar at the top 
of the screen, click the ‘Edit’ menu button and click the ‘Copy’ button on 
the menu.  Move your cursor to where you would like the new table to 
start (for example Cell A16).  Then pull down the ‘Edit’ menu again and 
click the ‘Paste’ button.   
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5. You will now add the other columns to the new table.  Select the cells in 
the next column you would like in your chart and copy and paste them (as 
per the directions in Step 4) next to the new ‘Area’ column (for example in 
Cell B16).  

 

 
 
6. Repeat step 5 for all the columns you would like in your chart. 
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7. When you have all of the columns you want in your new table, select all of 

the cells in your new table.  On the menu bar at the top of the screen, click 
the ‘Insert’ menu button and click the ‘Chart’ button on the Insert menu.  A 
dialogue box will open: 

 

 
 

8. Click on the type of Chart you would like.  For example, slide 7 has a Line 
Chart.  Click on Finish. 
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9. The chart of your data will then appear on the screen.  If you would like to 

change the background colour or other features of the chart, you can 
double click on the chart and explore the different options. 

 
10. To insert the chart into your slide, click on the chart.  On the menu bar at 

the top of the screen, click the ‘Edit’ menu button and click the ‘Copy’ 
button on the menu. 

 
11. Open the PowerPoint file containing the core slides. 
 
12. On the menu bar at the top of the screen, click the ‘View’ menu button and 

click the ‘Normal’ button on the menu. 
 
13. Click on the left of the screen where the numbers of the slides are listed 

and scroll through the slides (using the up and down keys on the 
keyboard) until you find the slide where you would like to put the chart.   

 
14. Click on the chart that is in the generic Basic Presentation.  Push the 

Delete button on your keyboard.  Pull down the ‘Edit’ menu as in step 4 
and click the ‘Paste’ button.   

 
15. This will insert the chart into the slide.  You can change the size of the 

chart by clicking on the white dots around the chart and moving your 
mouse.   

 
16. If you would like to change the chart in the next slide, repeat these steps.  

When you have finished, pull down the ‘File’ menu, click ‘Save As’, type 
the new file name and press ‘Save’. 
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Core Slide 8 – The Local Context – Part 2  
 

The local context – Part 2  

Trends in House and Rental Prices
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Notes to Presenter  
 
�  This slide in conjunction with Slide 7 should be used to demonstrate the housing 

affordability problem in your local area. 
 
�  This slide was prepared using information on the Newcastle LGA.  If the chart in 

Slide 7 compares the local area with other areas, this chart should focus solely 
on the local area.  For example, the change in affordability or house prices or 
rents over time. 

 
Background Information 
 
�  Information to create this chart is available in the Local Government Housing Kit 

and in Housing NSW’s Rent and Sales Report: 
 
 http://www.housing.nsw.gov.au/Rent%20and%20Sales%20Reports/ 
 
 To create a chart using data from the NSW Department of Housing’s Rent and 

Sales Report, open the Microsoft Excel program and insert the data into a new 
table.  Then create a chart as identified in the instructions for Core Slide 7. 

 



 �
���

Core Slide 9 – The Economic and Social Impacts  
 

The economic and social impacts 

Economic:
� Economic instability 
� Labour shortages 
� Loss of population  
� Increased demand for public housing

Social:
� Range of ‘human costs’
� Barrier to economic participation and educational 

opportunities  
� Reinforces patterns of segregation and exclusion 
� Greater demand for social payments

 
 

Notes to Presenter  
 
�  At this point in the presentation you have talked at some length about the actual 

problem in terms of numbers.  You will now go on to briefly talk through some of 
the economic and social impacts as a basis for illustrating how important the 
provision of affordable housing is.   

 
�  You may want to change the focus of the points on the slide in order to make 

them more relevant to the audience through a local example. 
 
In line with the bullet points on the slide, you may want to cover some of the following 
issues: 

 
Economic Impacts: 

 
�  Economic instability – At a macro-economic level, high house prices 

contribute to pushing wages higher and inflation as well.  Increasing levels of 
inflation can then threaten the stability of monetary policy.  On the other hand, 
high levels of household debt tend to reduce the level of consumption, and 
reduce economic growth.  These impacts are exaggerated if house prices are 
variable. 

 
�  Labour shortages - The supply of affordable housing has a serious impact on 

employment growth and regional economic development.  The loss of young 
families and workers in lower paid essential services jobs is bad for local 
economies and contributes to labour shortages.  Successful economies need 
plenty of low-paid service workers and medium-paid essential service 
workers.  If office workers, cleaners, bus drivers – not to mention other 
professionals – cannot afford to live near centres of economic activity, the 
local economy suffers from inefficient labour shortages.  Lack of affordable 
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housing can be a deterrent for young entrepreneurial and skilled workers and 
inhibit local economic growth. 

 
�  Loss of population - Rising housing costs in Sydney and broadly in NSW have 

led to increased migration to other States.  This has impeded population 
growth and economic growth particularly due to the resultant decline in 
consumer spending patterns. 

 
�  Increased demand for public housing – Poor housing affordability in the 

private market puts pressure on the public housing system.  
 

Social Impacts: 
 

�  Range of ‘human costs’ - There are a wide range of human costs associated 
with a lack of affordable housing.  For instance, some people are unable to 
afford basic expenses including food and clothing; some experience a 
negative impact on their health; some people become debtors; some live in 
sub-standard housing; some are disadvantaged by location; few people can 
afford recreation and leisure activities; following family separations, families 
often are unable to afford to remain living in the local area; children are often 
unable to afford to live in the same area as their parents. 

 
�  Barrier to economic participation and educational opportunities – Without 

access to affordable, secure and well-located housing it is difficult for people 
to take advantage of employment opportunities.  It also negatively impacts on 
educational opportunities.  Children need a home in which to grow up and 
they benefit from a stable environment that enhances opportunities to develop 
friendships and minimises interruptions to their schooling.     

 
�  Reinforces patterns of segregation and exclusion – The lack of affordable 

housing in high cost areas can force low and moderate income households to 
more affordable areas. This affects social mix, and can force out long 
established community members and threaten the cohesion of the broader 
community. Lower income households can become trapped in low cost, low 
amenity neighbourhoods that may have poor access to transparent or job 
opportunities, thereby further limiting their choices and perpetuating their 
disadvantage.   

 
�  Greater demand for social payments – Poor affordability can lead to 

increased expenditure on social payments for welfare and health services by 
national, state and local government agencies. 

 
It is important to stress at the end of this slide that the lack of affordable housing can 
have immense economic and social impacts.  Therefore the provision of affordable 
housing needs to be considered as part of a strategic policy approach. 
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Core Slide 10 – What is being done to address this?   
 

What is being done to address 
this problem?

� International Recognition

� National Recognition
� Framework for National Action on 

Affordable Housing

� Federal Government Action on 
Affordable Housing

� State-Wide Recognition 
� NSW Initiatives to Boost 

Affordable Housing

� Planning for the Future
� Metropolitan Strategy

 
 
Notes to Presenter  
 
�  At this point in the presentation, you have talked about the problems in terms of 

numbers and have identified a number of economic and social impacts.  You will 
now talk the audience through what is being done at the international, national 
and state-wide level to address housing affordability.  This will show that there is 
now a need for action at the local level, hence the reason why you are doing this 
presentation.     

 
�  Going through the bullet points on the slide, you may want to cover some of the 

following details: 
 

�  International Recognition – The decline in housing affordability is not unique 
to Sydney.  Housing affordability has declined in all the major cities across the 
globe.  However, the OECD rates Australia as having amongst the least 
affordable housing in the world, particularly when considering prices in 
relation to income.  Many countries are also trying to tackle the problem – for 
instance, in the UK, the government has intervened strongly to improve 
housing affordability in recent years, through substantial land releases in 
growth centres around London, increased use of planning powers to secure 
affordable housing, and a doubling of funding programs for affordable 
housing.       

 
(OECD 2005, Economic Outlook No 78, Paris) 

 
�  National Recognition – The seriousness of the situation has now been 

recognised at the Federal level.  A joint meeting of State, Territory and 
Australian Government Ministers for Housing, Local Government and 
Planning in August 2005 agreed to adopt a Framework for National Action on 
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Affordable Housing.  This includes a range of initiatives to address the 
predicted shortfall in Affordable Housing in many parts of Australia.   

 
(A copy of the Framework can be found on the following website – 
www.alga.asn.au) 
 
The Federal Government has also announced a number of new initiatives to 
support the growth of affordable housing.  More details are provided on the 
next slide. 

 
�  State-Wide Recognition - Within NSW, the importance of housing affordability 

has been identified through three key developments: 
 

o The release of several new initiatives to boost the supply of affordable 
housing, including boosting resources through a $49.8m Affordable 
Housing Innovations Fund, building capacity through long term leases 
for existing community housing properties, and investing in community 
housing providers to deliver their own housing. 

 
o Planning for the Future – The NSW Strategy to grow the community 

housing sector. 
 
o The Metropolitan Strategy 
 
o First Home Plus and First Home Plus One – The NSW Government’s 

First Home Plus scheme exempts first home buyers from transfer duty 
for properties valued up to $500,000 and provides concessions on 
duty for homes between $500,000 and $600,000.  Under First Home 
Plus One, the NSW Government has expanded this to allow first home 
buyers to purchase properties with other parties and still receive 
concessions on transfer duty, subject to the buyer purchasing at least 
50% of the property 

 
o Land tax concession - To attract greater private investment in the 

residential property market, the NSW Government has also 
announced that mortgage duty on the purchase of residential 
investment property will be abolished on 1 July 2008 and that the land 
tax rate will be cut from 1.7 per cent to 1.6 per cent for the 2008 land 
tax year. 

 
(Planning for the Future is available at: 
http://www.housing.nsw.gov.au/Office+of+Community+Housing.htm) 
 
 (The Metropolitan Strategy is available at 
http://www.metrostrategy.nsw.gov.au) 
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Core Slide 11 – At the national level  
 

At the national level

� The Federal Government has announced new 
initiatives to address affordable housing.  A 
working group of the Council of Australian 
Governments has been established to 
implement:
� a $500 million Housing Affordability Fund
� a National Rental Affordability Scheme
� building 600 new units for homeless people
� an audit of Commonwealth, State and Territory land
� a new National Housing Supply Research Council

 
 
Notes to Presenter  
 

�  In December 2007, the Council of Australian Governments established a Housing 
Working Group to progress work on five key initiatives: 

 

�  A $500 million Housing Affordability Fund with the goal of streamlining 
development approval processes and reducing infrastructure charges and 
developer costs.  

 
�  A National Rental Affordability Scheme, addressing rental affordability, by 

increasing the supply of affordable rental housing, conditional on financial 
support from the States and Territories.  

 
�  Building 600 new houses and units for homeless people, requiring a matching 

investment and the release of suitable land from the States and Territories.  
 
�  A plan for an audit of Commonwealth, State and Territory land for possible 

release for housing development (excluding operating Defence bases).  
 
�  The Commonwealth will seek State and Territory participation in the work of 

its new National Housing Supply Research Council, which will coordinate 
housing research and report on the adequacy of construction and land supply 
for the next 20 years.  

 

 



 �
���

Core Slide 12 – Affordable Housing Innovations Fund  
 

$49.8m Affordable Housing 
Innovations Fund

� Established by NSW Government to boost 
supply of affordable housing

� $10.4m for new affordable housing at St Marys

� $39.4m for debt equity partnerships with 
community housing providers
� State government contributes 60% of funds
� Community housing providers contribute a mix of 

equity and debt finance
� Tenders to be streamlined with the NRAS

 
 

Notes to Presenter  
 

�  In early slides, you have established the extent of the housing affordability 
problem and talked generally about initiatives to address the problem.  You will 
now talk about a specific funding opportunity for community housing and local 
government to work together to address housing affordability in the local area.  
More information will be provided in later slides on developing a partnership 
between community housing and local government, and this slide will 
demonstrate that there are opportunities to take advantage of. 

 

�  Going through the bullet points on the slide, you may want to cover some of the 
following details: 

 

�  The $49.8 million Affordable Housing Innovations Fund was announced in 
March 2006.  The Fund has allocated $10.4m in grant funding to develop 
affordable housing on a private development in St Marys.   

 

�  The remaining $39.4m is dedicated to projects with the community housing 
providers, where providers bring a minimum of 40% of project costs through a 
mix of debt finance and equity.  Three tenders for debt equity projects for 
$22.9 million have already been awarded. Further tenders will be streamlined 
with the National Rental Affordability Scheme. 

 

�  More information on the Fund is available on the Centre for Affordable 
Housing’s website: 
http://www.housing.nsw.gov.au/Centre+For+Affordable+Housing/ 
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Core Slide 13 – What can we do at the local level? 
  

What can we do at the local level?

AFFORDABLE HOUSING PARTNERSHIP

Local Government
&

Community 
Housing 

Organisation

 
 
Notes to Presenter  
 
�  You have demonstrated the activity that is occurring at the international, national 

and state level.  There is also the opportunity for action at the local level and you 
would like to suggest the development of an Affordable Housing Partnership 
as a vehicle for taking forward this agenda. 

  
�  The Affordable Housing Partnership  is a local strategic partnership that will 

work to tailor a specific response based on local need and local opportunities.  In 
this way, the partnership will: 

 
�  Identify the key local issues – Is there a requirement for affordable housing?  

If so, what’s the nature of this requirement?  Who are the key target groups? 
 
�  Identify the opportunities – what are the opportunities in the local area? What 

can the Partnership realistically do?  What other partners need to be engaged 
in the process (e.g. private sector, local community, etc) to achieve the 
desired outcomes?   

 
�  In relation to this agenda, it is important to emphasise that you will both bring a 

specific set of skills to the Partnership and that you will briefly go through these in 
the next couple of slides.   
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Core Slide 14 – Role of Local Government in the Par tnership 
 

Role of local government in the 
Partnership

� research, planning & 
design expertise 

� land, housing or $’s 
created through planning 
instruments / mechanisms 

� resources from surplus 
land or building audit, or 
land banking 

� other funding or resources 
from rates, grants, etc 

Affordable Housing Units created by 
Waverley Council Planning Mechanisms

Local Government can 
provide strategic direction 
and leadership. It can also 
bring:

 
 
Notes to Presenter  
 
�  As part of this slide you talk through what local government can bring to the 

Affordable Housing Partnership. 
 
 

�  It is important to stress the strategic role of local government in being able to 
provide leadership in the locality on issues such as affordable housing.  In this 
respect, local government can assume the role of ‘facilitator’ in drawing together 
the appropriate partners and ensure that the issue gets the attention it deserves.  
Local government can also increase the importance of issues at the local level by 
making sure that something as crucial as affordable housing is included within 
their strategic directions and so raise the profile of the issue at the local level.      

 
�  Although not historically involved in the provision of housing, local government 

has long played an important role in influencing  the supply of housing, including 
its costs, timing, location and amenity.  Some of the ways that local government 
influences housing supply include: 
 
�  Strategic planning policies and regulatory controls – e.g. zoning, building and 

urban design standards impact on where and how development can occur; 
 
�  Individual and cumulative planning decisions – e.g. permitting development 

and redevelopment of certain sites/properties over time; and other planning 
mechanisms to influence physical form and cost; 

 
�  Provision of infrastructure – e.g. parks, lower order roads, sewerage to 

facilitate land release which also affects amenity and cost; 
 
�  Levying of rates and rating policy generally; 
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�  Social planning to ensure adequate provision of social services to meet the 
needs of residents, students, volunteers and workers.           

 
�  Councils in various areas of NSW have already entered into Affordable Housing 

Partnerships with community housing providers.  For instance: 
 
�  Some councils have assisted with housing research, and with information or 

expertise on planning, building or design.  For example, they’ve made the 
skills of in-house staff available in the development of affordable housing 
projects.   

 
�  Other councils have used their planning powers to generate land, housing 

units or cash contributions for the creation of affordable housing.  These have 
formed part of the equity required to generate additional affordable housing, 
or housing created has been given to community housing organisations to 
manage under a deed of agreement. 

 
�  Some councils have contributed land identified as surplus to their needs to an 

affordable housing partnership.  Some have also provided land accumulated 
through ‘land banking’. 

 
�  Others have dedicated funding from other sources (e.g. rates, grants, etc) to 

affordable housing projects.  For example, they have waved rates on 
affordable housing projects, provided rent-free premises or administrative 
support to housing associations.      

 
�  State that specific examples will be provided when discussing the potential 

opportunities in the next slides  
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Core Slide 15 – Role of Community Housing in the Pa rtnership 
 

Role of community housing in 
the Partnership 

� Community housing is 
recognised as a key 
channel for the delivery 
of ‘affordable housing’ –
Why?

� Community housing 
can act as a:
� project partner
� source of funds 
� property and/or tenancy 

manager����������	
����
���
����

 
 
Notes to Presenter  
 
�  As part of this slide you will talk through what community housing can bring to the 

Affordable Housing Partnership. 
 
�  As indicated on the slide, it is necessary as a starting point to talk about why the 

community housing sector has been identified as a key channel, both at the 
national and state wide level, for the delivery of affordable housing options.  This 
is primarily due to their not-for-profit status and the following: 

 
�  The capacity of the sector to partner with, and attract finance from, the private 

sector, thus maximising the value of subsidy dollars; and 
 
�  The capacity of the sector to contribute to a range of broader objectives 

(including sustainable communities, economic participation and welfare 
reform). 

 
�  As indicated on the slide, you should now talk through what the community 

housing sector can bring to the Partnership: 
 

�  Project Partner  
Community housing has developed a range of skills in the development of 
housing projects in partnership with other organisations.  

 
�  Source of Funds 

Community housing organisations:  
o Can attract additional financial assistance through Commonwealth Rent 

Assistance; 
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o Can leverage investment through borrowings – Community housing 
providers often have a substantial portfolio of stock that they manage and 
may own, or have shared equity in.  They have the ability to access debt 
financing where projects are appropriately geared, and they can 
demonstrate to financial institutions that they have sufficient equity and 
income to repay loans; and      

 
o Can decrease construction costs through their exemptions from many 

taxes, including GST, due to their charitable status and their ability to 
reinvest development profit into affordable housing. 
  

�  Property and/or Tenancy Manager  
Community housing provides high quality housing and financial management 
and are accountable to Government – Community housing providers go 
through a rigorous registration process (which is managed and maintained by 
the Office of Community Housing) that ensures high quality management and 
accountability.  They have detailed and appropriate organisational structures 
(often responsible to a Board), policies and procedures that enable them to 
take on any stock created as a result of an affordable housing partnership.  
They help manage the risks. 
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Core Slide 16 – What can my Organisation bring to t he 
Partnership? 
 

What can my organisation bring to 
the Partnership?

(Information to be inserted here by community 
housing provider – please refer to the Users 

Manual)

 
 
Things to do in Advance   
 
�  Insert information into this slide that demonstrates your organisation’s ability and / 

or experience to deliver affordable housing - this could therefore include: 
 

�  Information on any key affordable housing projects that your organisation has 
been involved with – do you have any development expertise? 

 
�  Any awards that your organisation has received. 
 
�  Details of your Board - have any of your Board Members got experience 

within this area? 
 

It is important that you keep this information to one slide. 
 
Notes to Presenter 
 
�  When you are talking the audience through this slide, do not forget that one of 

your major strengths is the fact that you are a stakeholder within the local 
community and therefore have a detailed local knowledge of the issues and 
opportunities. 

   
It is important that you provide more information than you presented in slide 3. 
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Core Slide 17 – Where to from here? 
 

Where to from here?

� Commitment to establishing an Affordable Housing 
Partnership – complex problems require holistic 
solutions

� Beginning of discussion on:
� Local needs and solutions – i.e. diagnosis of the 

problem and potential opportunities for joint working   
� How we can work together – identification of the ways 

we can work together – what can the partnership do?   
� Possible implementation mechanisms  

 
 
Notes to Presenter 
 
�  This is the final slide of the presentation and you should use it as an opportunity 

to propose a way forward in your further discussions or the next steps in 
developing your Affordable Housing Partnership with your council. 

 
�  If you are aware of specific local opportunities for developing an Affordable 

Housing Partnership, you could raise them here if it seems appropriate. 
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Core Slide 18 – Acknowledgements 
 

Funding for this Project was provided by

business units of

 
 
Notes to Presenter 
 
This slide details the project funders.  
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4. SUPPLEMENTARY SLIDES  
 
The supplementary slides provide more detail on the technicalities of affordable 
housing provision with a local government partner.  If you decide to deliver these 
slides, it is important to ensure that your presentation of the material is technically 
correct, as the audience will be familiar with the material.  The Centre for Affordable 
Housing is available to provide expert advice before you present the material. 
 
There are two separate sections to the supplementary slides – these are as follows: 
 
Section 1 – Role of Local Government   
 
The following slides can be inserted after Core Slide 14 .  They explore the role of 
local government as well as some of the mechanisms available to them and how 
these can be used at the local level to encourage the provision of Affordable 
Housing.  This incorporates the following slides: 
 
1 – Local Government Role in Affordable Housing – Context  
2 – Mechanisms available to Council  
3 – Affordable Housing Mechanisms (1) 
4 – Affordable Housing Mechanisms (2) 
5 – Affordable Housing Mechanisms (3) 
6 – Affordable Housing Mechanisms (4) 
 
Section 2 – Affordable Housing Partnership Examples   
 
The following slides can be inserted after Core Slide 16 .  They provide specific 
examples of what the Affordable Partnership can do.  This incorporates the following 
supplementary slides: 
 
7  –  Debt Financing Partnership 
8  –  Planning Partnership 
9  –  Partnership on Surplus Land  
10  –  Partnership using Environmental Planning Instruments  
11  –  Section 79C Example  
12  –  Self Build Partnership 
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SUPPLEMENTARY SLIDES 
SECTION ONE 
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Supplementary Slide 1 – Local Government Role in Af fordable 
Housing – Context  
 

Local Government Role in 
Affordable Housing – Context

� AH objective in EP&A Act in 1999 
(section 5(a)(viii))

� AH levy per s94F & 94G (but limited by 
SEPP 70 to 2 LGAs)

� Strengthening of SEPP 10 in 2000
� Social Plans, State of the Environment 

Reports, etc, under LGA 1993
� ‘Social and economic impacts’ under 

section 79(C) (1) (b) of EP&A Act 1979
 

 
Notes to Presenter 
 
�  This slide explores the powers that councils have specifically for the retention or 

creation of affordable housing.  So what powers do councils have specifically for 
retention or creation of Affordable Housing? 

 
�  The Environmental Planning and Assessment Act 1979 (NSW) was amended 

in 1999 to include an objective specifically related to affordable housing.  
Section 5(a)(viii) states that an objective is ‘to encourage the provision and 
maintenance of affordable housing’.   The Act was further amended in 2000 to 
introduce sections 94F and 94G (which will be dealt with later).  At present, 
only two Councils levy developers under these provisions (City of Sydney and 
Willoughby City Council).  Despite this, there are still a range of mechanisms 
open to councils. 

 
�  Councils are also required to comply with State Environmental Planning 

Policy No. 10 (Retention of Low Cost Accommodation).  This SEPP aims to 
limit the loss of low cost flats, units and boarding houses.  Despite its 
existence, a majority of low cost flats and boarding houses have been lost 
through strata subdivision or redevelopment since the 1980s.  The provisions 
of SEPP 10 were strengthened and extended to more council areas in 2000, 
but the impact of these changes are reported to be mixed to date. 

 
�  Under the Local Government (General) Regulation 2005 it is mandatory for all 

NSW councils to prepare social/community plans at least every 5 years.  
Plans include a human needs assessment that must consider the needs of 
seven ‘target groups’ in the community that may face disadvantage (e.g. 
Aboriginals and Torres Strait Islanders, people with a disability, older people), 
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for which Affordable Housing issues are often central concerns.  It is also 
mandatory for councils to prepare Management Plans (including an Access 
and Equity Statement), State of the Environment Reports and Local 
Environmental Plans.  Housing is an important access and equity issue as 
well as part of the local ‘environment’, and it is therefore appropriate to 
consider this issue under these plans also.  

 
�  Finally, councils must consider the social and economic impacts of a 

development under section 79C (1) (b) of the EP&A Act.  The loss of 
affordable housing may be a serious social and economic impact in a locality, 
particularly where housing is already unaffordable, or where the loss is 
substantial.  ‘Cumulative’ impacts (small individual losses of affordable 
housing that lead to large loss over time) can also be considered.  

 
Background Information 
 
In NSW, local councils have a clear responsibility to ensure that there is an adequate 
supply of a range of housing to cater for the needs of all residents.  Local 
government has express roles and responsibilities relating to affordable housing 
under various bodies of legislation and environmental planning instruments (EPIs).  
 
Briefly, there are four main areas under which Councils must consider issues related 
to Affordable Housing: 
 
1. The NSW Environmental Planning and Assessment Act 1979  (EP&A Act) 

amended in 1999, 2000 and 2005: 
 

�  To introduce a specific Affordable Housing objective (1999);  
 
�  To allow councils to levy developers for in-kind or cash contributions to 

Affordable Housing under s94f & s94g (2000).  However, to do so, a planning 
scheme must be nominated under State Environmental Planning Policy No. 
70 (SEPP 70).  At present, only three planning schemes in two LGAs are 
recognised under SEPP 70 (in City of Sydney and Willoughby council). 

 
�  However, despite the limitations imposed by SEPP 70, other mechanisms are 

available to Councils to encourage the provision and maintenance of 
Affordable Housing per the objectives.   

 
�  Most recently, the Environmental Planning and Assessment Amendment 

(Development Contributions) Bill was passed on 4 May 2005.  The Bill, which 
amends the EP&A Act 1979,  provides a statutory framework for negotiated 
developer contributions with respect to development applications, which are 
described as ‘Planning Agreements’.  These amendments have now been 
incorporated into the EP&A Act at a number of points, and are set out 
principally under section 93F.  A ‘Planning Agreement’ allows for the 
negotiation of planning agreements prior to developers submitting 
development applications or seeking alterations to planning instruments, or to 
be developed concurrent with consideration of a DA.  It will form a condition of 
consent, provided it is in terms of an offer made by a developer (i.e. it is 
voluntary).  However, the details may be worked out after consent is granted.  
Planning Agreements can operate in addition to the normal provisions of s94, 
and may be entered into for a number of specified purposes, including 
‘Affordable Housing’.      
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2. Strengthening State Environmental Planning Policy 10 (SEPP 10): 
 

�  SEPP 10 was amended in 2000 to strengthen its provisions, and to include 
additional council areas in recognition of widening geographic pressure on 
stock at the most affordable end of the housing market (boarding houses, 
hostels, and low cost flat buildings).  It now includes all LGAs in Greater 
Sydney.  

 
3. Preparation of Social Plans under NSW Local Government Act 1993: 
 

�  Under the Local Government (General) Regulation 2005 it is mandatory for all 
NSW councils to prepare social / community plans at least every 5 years 
including demogrphic data, a human needs assessment, consideration of the 
needs of seven target groups that may face disadvantage within the 
community (Aboriginals and Torres Strait Islanders, children, people from 
culturally and linguistically diverse backgrounds, people with a disability, older 
people, women, young people), a review of the previous social plan as well as 
recommended actions that may become priority initiatives to include in the 
council’s Access and Equity Statement within its Management Plan. 

 
�  Councils report on Access and Equity achievements in their Annual Reports.  

Many councils identify Affordable Housing objectives in this process.  The 
Social and Community Planning and Reporting Guidelines (2002) and Social 
and Community Planning and Reporting Manual (2002) include reference to 
housing issues and examples.  Both are available on the Department of Local 
Government website at www.nsw.gov.au 

 
4. Section 79(C)(1)(b) of the EP&A Act 1979: 
 

�  Requires councils to consider the ‘social and economic impacts in the locality’ 
of any development application (including redevelopment proposals) 

 
�  The social and economic impacts of development/redevelopment in a given 

locality may lead to the refusal of a Development Application by the consent 
authority (generally council) if the social impacts arising are assessed as 
being serious, and/or unable to be remedied.1   

 
�  Alternately, conditions of consent may be imposed that seek to mitigate the 

loss of Affordable Housing in a locality (e.g. through replacement of a 
proportion of the housing lost, compensation to displaced householder, or 
other measures). 

 
�  It should be noted that, although councils’ power under this section of the Act 

is clear, this provision is largely untested in relation to Affordable Housing.  
However, some councils have refused applications that will lead to the loss of 
significant amounts of affordable housing under this section 79C, and are 
facing appeals of these directions in the NSW Land and Environment Court at 
the time of writing.  

 
�  In terms of recent amendments to and powers under the NSW EP&A Act 

1979, more detailed information is set out in a range of resources listed 
below.   

                                                
1 �����������	
������
��������������������������� ��������	
�������
��
�� ����
���������������
��
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o You may like to visit the website of Shelter NSW which hosts the web 
page of the NSW Affordable Housing Network at: 

www.shelternsw.infoxchange.net.au/ahn/ahn.html 
A useful document has been produced by members of the Network: 
Thorpe, Miers, Stubbs, Richardson & Berryman (2004), Enhancing the 
role of local government in affordable housing: options for improving our 
planning system, available in full at: 

www.shelternsw.infoxchange.net.au/ahn/ahn-post0412optionspaper-
f.pdf 

 
o A useful sheet on the recent Environmental Planning and Assessment 

Amendment (Development Contributions) Bill 2005 is available from 
Allens Arthur Robinson’s website at: 

www.aar.com.au/pubs/fmres/foplfeb05.htm 
 
o In terms of SEPP 10 specifically, a useful information sheet is available 

through the NSW Department of Infrastructure, Planning and Natural 
Resources (DIPNR) at: 

www.planning.nsw.gov.au/settingthedirection/pdf/sepp10/infosheet.pdf 
 
o The full SEPP is available from the DIPNR website: 

www.planning.nsw.gov.au/settingthedirection/pdf/sepp10/sepp10no.p
df 

 
o A copy of SEPP 70 is available also from the DIPNR website at: 

www.planning.nsw.gov.au/settingthedirection/pdf/sepp70.pdf 
 
o S79C(1)(b) of the NSW Environmental Planning & Assessment Act 1979 

states that, in determining a development application, a consent authority 
is to take into consideration…the likely impacts of that development, 
including the social and economic impacts in the locality. 
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Supplementary Slide 2 – Mechanisms Available to Cou ncil  
 

Mechanisms available to Council

� Use of planning instruments to create 
or retain AH (dwellings, land or $s) 
under s26

� Mechanisms include:
� Planning Agreements under s93F of the EP&A Act 

1979
� Density Bonuses
� Inclusionary Zoning (only two LGAs under SEPP 70)
� Refusal of DAs or mitigation under s79C(1)
� Development and Management Partnerships

 
 
Notes to Presenter 
 

�  This slide provides an overview of the planning mechanisms available under 
current NSW legislation, which local government can use to generate 
contributions (land, housing dollars) to an AH Partnership.  The mechanisms are 
explored in detail in Supplementary Slides 3 to 5. There are important 
opportunities for local government to be leaders in the creation of affordable 
housing, and to work toward retaining as much affordable housing as possible in 
their local area.One of the most important things Council can do is to incorporate 
objectives and mechanisms for creating and retaining AH into its planning 
instruments (LEP, DCP and AH Plan) through section 26.  This should be based 
on thorough research and consultation on local housing needs and issues; and 
incorporate clear targets, monitoring, evaluation and reporting mechanisms 
(linked for example to the council’s corporate or business plans). 

 
�  Some supporting mechanisms include: 

 
�  Planning Agreements and Density Bonuses; 
 
�  Inclusionary Zoning (can only be used in Sydney City, Redfern Waterloo 

Authority and Willoughby at present); 
 
�  Careful consideration of all developments that involve loss of AH; 
 
�  Development/management partnerships with the community sector. 

 
�  The presentation will focus on partnership opportunities.  However, these 

partnerships will often involve the use of some or all of these mechanisms.  
These will be explained as you go through the slides.  
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Supplementary Slide 3 – Affordable Housing Mechanis ms (1) 
 

� Planning Agreements:
� Formalised under section 93F of the EP&A Act 1979

� Provide for negotiated developer contributions including 
for the purpose of AH

� Must be voluntary in form of an offer from developer

� Negotiated prior to or concurrent with DA

� Details may be worked out after consent

� Binding as a ‘condition of consent’

� Operate in addition to normal provisions of s94 & 94A

Affordable Housing 
Mechanisms (1)

 
 
Notes to Presenter  
 
�  Planning Agreements provide the framework for councils to negotiate affordable 

housing and other contributions prior to developers submitting development 
applications or seeking alterations to planning instruments, or to be developed 
concurrent with consideration of a DA.  It will form a condition of consent, 
provided it is in terms of an offer made by a developer (i.e. it is voluntary).  They 
operate in addition to the normal provisions of sections 94 and 94A (developer 
contributions). 

 
�  The Act notes that Planning Agreements may contain provisions related 

specifically to Affordable Housing, which may include the dedication of land or 
money or dwellings for Affordable Housing.  They are therefore not constrained in 
the way that section 94 is limited, provided the Agreement is entered into 
voluntarily by the applicant.  This Agreement may be most feasible where there is 
significant benefit to the applicant (e.g. in the case of land rezoning).     
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Supplementary Slide 4 – Affordable Housing Mechanis ms (2)  
 

Affordable Housing 
Mechanisms (2)

� Floor Space Ratio (FSR) or Density 
Bonuses:
� Targeted areas or precincts  (e.g.  near transport and 

services)
� Planning controls are varied to allow for higher densities 

provided a proportion of stock created is dedicated to AH
� Most effective in high land value/high demand areas
� Need to ensure transparency
� Ensure added density does not lead to overdevelopment or 

design compromises
� Some community resistance – perception of over 

development or design compromise

 
 
Notes to Presenter 
 
�  Density bonuses generally involve approval for a development with density or 

Floor Space Ratio (FSR) in excess of that which would generally be allowed by 
council’s planning controls, provided a proportion of the additional housing or 
other resources is dedicated to ‘Affordable Housing’ (e.g. rental housing to which 
council has title and which is managed by a community housing provider). 

 
�  Areas in which density bonuses would apply would generally be identified in 

council’s planning instruments, and would generally be targeted to areas or 
precincts that are close to transport, services and retail facilities.  They work most 
effectively in high land value/high demand areas where developers can offset 
reduced profits against higher housing yield. 

 
�  It’s important to approach density bonuses schemes in a transparent way with 

controls to ensure that it does not lead to overdevelopment or design 
compromises. 

 
�  There has been some community resistance to such density tradeoffs, in part due 

to a community perception that they may lead to over-development of the site, or 
to design or amenity being otherwise compromised.  However, there is a range of 
ways that density can be increased within a particular development that minimise 
the impact on visual amenity.  
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Supplementary Slide 5 – Affordable Housing Mechanis ms (3) 
 

� Inclusionary Zoning:
� Mandatory provisions requiring particular sites or 

forms of development within a certain area/zone 
to allocate % as AH

� Limited as operationalised through SEPP 70 (only 
applies to planning schemes in City of Sydney, 
Redfern Waterloo Authority and Willoughby)

� AH provided on-site or by way of monetary/land 
contribution

Affordable Housing 
Mechanisms (3)  

 
 
Notes to Presenter  
 
Inclusionary Zoning: 
 
�  Introduces provisions into planning controls that require particular sites within an 

area or zone, or particular forms of development, to allocate a proportion of that 
development as Affordable Housing 

 
�  The introduction of section 94F and 94G to the NSW Environmental Planning & 

Assessment Act 1979, in 2000, provides for councils to levy developers for a 
contribution (in-kind or cash) to Affordable Housing. 

 
�  However, to do so, a planning scheme must be nominated under State 

Environmental Planning Policy No. 70 (SEPP 70).  At the present time, only 3 
planning schemes in two LGAs are recognised under SEPP 70 (in City of Sydney 
and Willoughby councils areas). 

 
�  Affordable Housing is generally either provided on-site or by way of an in-lieu 

monetary contribution. 
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Supplementary Slide 6 – Affordable Housing Mechanis ms (4) 
 

Affordable Housing 
Mechanisms (4)

� Application of S79C (1) (b) of EP&A Act 
1979:
79C(1) In determining a development application, a consent 
authority is to take into consideration………………

(b) The likely impacts of that development, 
including…the social and economic impacts in the 
locality.

� Refusal if serious impacts may be appropriate
� Mitigation to remedy impacts where appropriate

 
 
Notes to Presenter  
 
�  Section 79(C)(1)(b) of the EP&A Act 1979 requires councils to consider the 

‘social and economic impacts in the locality’ of any development application 
(including redevelopment proposals). 

 
�  The social and economic impacts of a development or redevelopment in a given 

locality may lead to the refusal of a Development Application by the consent 
authority (generally council) if the social impacts arising are assessed as being 
serious, and/or unable to be remedied. 

 
�  Alternatively, conditions of consent may be imposed that seek to mitigate the loss 

of Affordable Housing in a locality (e.g. through replacement of a proportion of the 
housing lost, compensation to displaced householder, or other measures).  The 
use of a ‘Planning Agreement’ under section 93F of the Act may be more 
appropriate. 

 
�  Although council’s power under this section of the Act is clear, it should be noted 

that this provision is largely untested in relation to Affordable Housing in NSW.  
However, some councils have refused applications that will lead to the loss of 
significant amounts of Affordable Housing under section 79C, and are facing 
appeals of these decisions in the NSW Land and Environment Court at the time 
of writing.    

 
�  See Supplementary Slide 11 for examples of usage of Section 79C. 
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SUPPLEMENTARY SLIDES 
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Supplementary Slide 7 - Debt Financing Partnership  
 

Debt Financing Partnership 

� Council identifies surplus land or $$ and makes 
contribution to a community housing provider

� Provider uses existing equity, own surplus and/or 
council contribution

� Provider obtains finance based on equity and income 
stream

� Title may be shared or held by either Council or the 
provider

� Units created may be used for mixed income group

 
 
Notes to Presenter 
 
�  Increasingly, community housing providers are exploring new ways of financing 

AH.  This example from Balgownie in Wollongong is owned and managed by The 
Housing Trust, and was completed in February 2002 at a cost of $1.2million.  It 
consists of five 2-bedroom villas and townhouses, and is the result of a 
partnership between The Housing Trust, Wollongong City Council (WCC), and 
the National Bank. 

 
�  The partnership worked in the following way: 
 

�  WCC dedicated funds to the project that were collected under section 94 
(from 1987 to 1992) and held in trust for AH. 

 

�  Through efficient housing management, The Housing Trust had accumulated 
funds to contribute and The Trust was able to secure NAB finance due to a 
substantial deposit from WCC and their own reserves, as well as their track 
record as an efficient housing manager and ability to demonstrate that they 
could make loan repayments through rental income on the 5 units. 

 

�  The target group is low to very low income group, but this project would be 
suitable for moderate income or mixed income groups. 

 

�  Councils can make the best use of limited resources by partnering with a 
community housing provider that can attract finance and use its charitable 
status to generate tax benefits.  NSW Government has provided grant funds 
under a range of programs to supplement capital contributed by Council or 
the community housing provider. 
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Supplementary Slide 8 – Planning Partnership  

 

Planning Partnership

� Partnership using 
Provisions of EP&A Act 
1979:
� Developer seeks rezoning leading 

to major land appreciation
� Developer offers to enter into a 

Planning Agreement under s93F
� Offers AH contribution in exchange 

for concessions
� Council keeps title to AH created
� Housing managed by community 

housing
� Mixed Income group including low 

income workers

���������	
���
����
���	�����

 
 
Notes to Presenter   
 
�  Voluntary Planning Agreements under section 93F of the NSW Environment 

Planning and Assessment Act are a fairly new development, though many 
councils have used this type of negotiation with developers for some years, 
particularly in cases where there are major benefits available to the developer 
(e.g. in the rezoning of land to residential uses). 

 
�  This section of the Act has now formalised these types of Agreements, provided 

they are entered into voluntarily by the developer.  Housing, land or funds 
generated may be used as part of an affordable housing partnership, and form 
part of the normal conditions of consent attendant to the approval of the 
Development Application. 

 
�  The City of Canada Bay adopted an Affordable Housing Policy on 7 August 2007 

which aims to assist local residents and/or local employees on low to moderate 
weekly incomes to access affordable rental housing in the Canada Bay local 
government area. 

 
�  To date, the City of Canada Bay has negotiated with a developer to deliver 15 

units of affordable housing which will be owned by the City of Canada Bay and 
managed by a community housing provider.  6 of those units will be accessible 
for workers of Concord Hospital that meet the City’s Affordable Housing Eligibility 
Criteria. 

 
�  Randwick City Council has also approved the use of voluntary planning 

agreements for affordable housing on Master Plans. 
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Supplementary Slide 9 – Partnership on Surplus Land   
 

Partnership on Surplus Land

� Council identifies surplus land and partners 
with developer

� Developer gives Council units to the value of 
land

� Council retains title to the units managed by 
community housing provider

� Units rented to working families at 75% of 
market rent

� No recurrent subsidy needed.

 
 
Notes to Presenter  
 
�  This example shows the potential for a three way Affordable Housing partnership 

between the Private, Government and Community, like that between City of Port 
Phillip Council, Port Phillip Housing Association, Inkerman Properties Pty Ltd, Vic 
Urban and others in the Inkerman Oasis Project.  A 1.2 hectare former Council 
depot site in St Kilda was rezoned residential.  A private developer was appointed 
after an open tender to develop the land in exchange for creating community 
housing to an agreed value (e.g. the value of the land).  Around 240 units were 
developed including 32 units of Affordable Housing.  These units are managed by 
Port Phillip Housing Association. 

 
�  Variations on this type of partnership are possible where a council has identified 

surplus land or redundant facilities which could be used as part of an Affordable 
Housing Partnership.  

 
 



 �
���

Supplementary Slide 10 – Partnership Using Environm ental 
Planning Instruments 
 

Partnership using Environmental 
Planning Instruments

� Council Housing Study 
identifies AH need and 
strategies  

� Council puts AH objectives and 
mechanisms in LEP and DCPs

� Includes incentives for 
developers who provide AH as 
part of certain developments

� Units created managed directly 
by Council or community 
housing provider

� Rented to low to moderate 
income families��������	
����
�
�������

��������������������
�

 
 
Notes to Presenter   
 
�  There are number of ways that councils can use their planning instruments (Local 

Environmental Plans and Development Control Plans) to create additional 
affordable housing in their area.  Generally, the council will have done research 
that indicates that there is a need for Affordable Housing, who most needs such 
housing, and the best way that it can assist in creating or retaining more 
affordable housing. 

 
�  One Council that has identified a need for Affordable Housing and has used its 

planning instruments to create more housing is Waverley Council, through a 
‘density bonus’ mechanism.  The main components of Waverley’s Affordable 
Housing Program are: 

 
�  Its planning instruments - Waverley’s Local Environmental Plan and 

Development Control Plan for Multi-Unit Housing define the density bonus 
mechanism.  In return for the provision of affordable housing, developers 
may increase the floor space ratio of their development, develop a larger 
building envelope, or do a combination of the two. 

 
�  Developers may negotiate with Council for the housing created to be held in 

Perpetuity or for a specified duration, and for it be rent-capped at a level 
below market rent. 

 
�  Council uses an Affordable Housing calculator – the calculator determines 

the ‘benefit’ from the density bonus to the developer (i.e. the increase in 
developable area) and to Council (i.e. affordable housing units).  The benefit 
is divided equally (50/50) if the contribution is provided in kind.  However, if 
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the affordable housing contribution is made in cash Council takes 75% of the 
benefit and the developer is left with 25%. 

 
�  Waverley has generated 21 affordable housing units through its Affordable 

Housing Program (10 owned by Council and 11 on fixed term rental 
agreements with developers for periods from 1 to 25 years).  Council aims to 
deliver 15 units a year through this mechanism.    
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Supplementary Slide 11 – Section 79C Example  
 

Section 79C Example

� Retention of AH using EP&A Act:
� A DA involves loss of AH 
� Council refuses DA under s79C(1)(b) of EP&A Act 1979
� Developer appeals and case goes to Land & Env. Court:

� Court finds in Council’s favour – AH preserved 

OR
� Developer offers to create AH through Planning Agreement 

under s93F – managed by community housing provider 

OR

� Developer wins appeal and AH lost

 
 
Notes to Presenter 
 
�  Gosford City Council refused an application for the redevelopment of a caravan 

park in its LGA due to the social impact that it would have on residents, and the 
loss of this type of Affordable Housing in the area.  The applicant appealed 
Council’s decision in the NSW Land and Environment Court in 2004.  The Court 
did not uphold the appeal as it decided that the social impacts of the 
redevelopment would be too great (i.e. Council's original decision was upheld).  
In this case, hundreds of units of Affordable Housing were preserved in the area 
(see Baker v Gosford City Council (No 2) [2004], NSW LEC 467). 

 
�  Other councils are also refusing such applications for redevelopment or change 

of use.  Fairfield City Council’s refusal of the application to redevelop 276 mobile 
homes and caravans at Lansdowne Caravan Park is one example.  Even if the 
Court does not find in favour of a council in these types of cases (and this is 
always a very real risk), the Council can seek some form of mitigation against the 
loss of housing in the locality in the same way it can seek mitigation for down 
stream effects of flooding and erosion.  Alternately, the developer may offer to 
enter into a planning agreement to dedicate some of the benefit gained through a 
redevelopment, change of use or rezoning for use as Affordable Housing.     
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Supplementary Slide 12 – Self Build Partnership  
 

Self Build Partnership

� Partnerships using 
Self-Build schemes:
� Council buys land and 

building materials, hires a 
building supervisor and 
recruits participants

� Families build houses, 
secure a mortgage using 
their ‘sweat equity’ as a 
deposit and then buy their 
homes from Council - e.g.  
Hume Shire Council���	
����	
�������
� �����


�	��
�����


 
 
Notes to Presenter 
 
�  Only a handful of group self-build projects have taken place in NSW.  Apart from 

Hume, projects have been run by Albury Council, Wagga Wagga Council, Central 
Tablelands Housing Association and Habitat for Humanity (primarily in Western 
Sydney). 

 
�  Group self-build schemes work best when: 
 

�  There are enough participants to share the building tasks in an equitable way, 
while not too many that supervision becomes difficult.  Around 10-15 
participants seems ideal. 

 
�  The land is not high cost and final house values are affordable.  Participants 

will need to take out a loan to cover the property at the end of the scheme, so 
it is important that participants can qualify for a loan to cover the value of the 
house. 

 
�  The scheme is a manageable length.  About 12 months seems best because 

it allows enough time to build the houses without losing momentum for the 
scheme.  This means that participants must contribute their time regularly. 
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LIST OF ACRONYMS  
 
AH Affordable Housing  

 
CAH Centre for Affordable Housing 

 
DA Development Application  

 
DCPs Development Control Plans 

 
DIPNR Department of Infrastructure, Planning and Natural Resources   

 
EP&A Act 1979 Environmental Planning and Assessment Act 1979 

 
EPI Environmental Planning Instrument  

 
LEP Local Environmental Plan 

 
LGA Local Government Area  

 
MTFAH Ministerial Task Force of Affordable Housing  

 
OCH Office of Community Housing  

 
SEPP 10 State Environment Planning Policy No.10 (Retention of Low 

Cost Rental Accommodation) 
 

SEPP 70 State Environment Planning Policy No.70 (Affordable 
Housing)  
 

WCC Wollongong City Council 

 
 


